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ASCENDER Business Release Notes

ASCENDER Release 6

ASCENDER 6.0700

Release Date: 3/10/2022 ASCENDER Update: 6.0700

Approval Summary

O Corrected the program to only display the Accounts Receivable > Invoice Approval link if the
logged-on user has pending invoice approvals.

Accounts Receivable > Tables > Customer Information

O Modified the program to prevent the first (default) customer record in the database from being
retrieved and edited as updates to this record can cause issues in Accounts Receivable and Finance.

Accounts Receivable > Maintenance > Invoice Approval

O Added validation to prevent approvers from clearing required fields (Unit Price, Item Total,
Amount, Offset accounts) on an invoice and then proceeding with approval.

Accounts Receivable > Maintenance > Invoice Inquiry/Customer Notes > Inquiry

[ Added the Credit Memo section with the following columns:

e Credit Memo Nbr
e Adjust Reason

¢ Account Code

e Amount

e User ID
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Bank Reconciliation > Tables > Reconciliation Layout > Categories

O Corrected the program to always display the +Add link. Previously, the +Add link was removed
when all categories were deleted from the page.

Finance > Tables > District Finance Options 2

O Corrected the issue that caused the value in the Next Available Travel Request Number field to
be converted and saved as invalid data in the database.

Finance > Tables > Bank Codes > Bank Codes

O Corrected the program to retain the sort order for the Bank Name column after using the
pagination feature.

Finance > Maintenance > Postings

O Corrected various user interface issues to improve the user experience across all tabs including
placing the cursor focus on the PO Number field after liquidating a purchase order on the Check
Processing - Purchase Order tab.

Finance > Utilities > Fiscal Year Close

[ Modified the program to properly handle adjustments, credit memos, and payments for invoices
allowing accurate information to be displayed on the Accounts Receivable > Reports > Accounts
Receivable Reports > BAR4000 - Invoice Listing by Revenue Code report.

Finance > Utilities > Positive Pay Export

O Corrected the PDF file to display all available records. Previously, only the first page of records was
displayed.

Finance > Reports > Finance Reports > Summary/Miscellaneous Reports >
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FIN3800 - Statement of Financial Position

O Corrected the out-of-balance condition that occurred when an LEA had encumbrances in balance
sheet accounts (object codes 1XXX, 2XXX, 3XXX, and 4XXX). Now, the Total Assets equal Total
Liabilities plus Net Assets, and the report is in balance.

Grants and Projects > Inquiry > GL Inquiry
O Modified the program to display the correct realized revenue/expenditure totals when retrieving
data from different file IDs.

[ Modified the program to remove the Est Rev (Estimated Revenue) and Approp (Appropriation)
columns from the summary view but still display them in the detailed view.

Payroll > Maintenance > Approve CIP

O Modified the program to correctly calculate the State Min Salary and Pct Assigned on the
Payroll > Maintenance > Staff Job/Pay Data > Job Info tab after approving a CIP.

Payroll > Payroll Processing > Run Payroll

O Corrected the issue that prevented the Employer Contrib field from being populated on the
HRS2200 - Payroll Earnings Register. Now, the correct EIC amount from the Pre-Post report is
displayed.

Payroll > Utilities > Mass Delete > YTD Transactions

O Corrected the program to only process the deletion if the user clicks Yes in the “Do you want to
process?” pop-up window. Previously, data was deleted regardless of the user's selection (Yes/No).

Payroll > Utilities > Salary Simulation > Simulation Options

O Corrected the issue that caused the Cancel button to display as 0 on the Salary Simulation - Error
Listing.
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Payroll > Utilities > Imputed Income Extract

O Corrected the spelling of Deductions in the following message: “Extracted Imputed Income
Deductions saved successfully.”

Payroll > Utilities > FFCRA Payments

O Removed this menu item as it is now obsolete and should no longer be used.

Payroll > Reports

O Modified the following reports to include the correct 403B FICA Contribution amounts.
e Year to Date Reports > HRS3050 - School YTD Report
e Year To Date Reports > HRS3250 - YTD Account Distribution Journal

e Year To Date Reports > HRS3450 - YTD Payroll Control Listing
¢ Payroll Reports > HRS2000 - Payroll Control Listing

Payroll > Reports > Payroll Reports > HRS2000 - Payroll Control Listing

O Removed the CSV option. As a result, the CSV button was disabled on the report parameters page
and the CSV icon was removed from the report.

Payroll > Reports > Payroll Reports > HRS2200 - Payroll Earnings Register

O Corrected the issue that prevented the Employer Contrib field from being populated on the
report. Now, the correct EIC amount from the Pre-Post report is displayed.

Payroll > Reports > WorkJournal Reports > PWJ1000 - WorkjJournal Report

O Added this report to provide a detailed listing of employee WorkJournal timesheet entries.
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[ Preview ] [ FDF ] [ csy ] [ Clear Options ]

[Workloumnal Reparts PWI1000 - Worklournal Report
FWI1000 - Worklournal Report -
PAWIL 100 - Worklournals Pending Approval

Parameter Description Value

Sort by Alpha [A), Work Week (W), Pay Date (P), Status [S) |:]

Select Frequencyfies), or blank for ALL

Select Employee(s), or blank for ALL

From Pay Date (MMDDYYY)

To Pay Date {MMDDYYYY)

To Work Week (MMDDYYYY)

Select Wark Week Statusies), or blank for ALL

Select Pay Campus(es), or blank for ALL

[
[
[
[
From Wark Wask (MMDDYYYY) (
[
[
[
Select Supervisaris), ar blank for ALL (

Payroll > Reports > WorkJournal Reports > PWJ1100 - Workjournals Pending
Approval

O Added this report to provide a listing of employee WorkJournal timesheet entries pending approval.

[ Preview ] [ FOF ] [ (8- ] [ Clear Options ]

Waorkloumnal Reports PWI1100 - Worklournals Pending Approval
PWI1000 - Worklournal Report X
PWI1100 - Waorklournals Pending Apgproval

Parameter Description Value

Sort by Alpha [A), Work Week (W] or Pay Date (P ﬂ:}

Select Frequency(ies). or blank for ALL

Select Employee(s), or blank for ALL

From Pay Date (MMDOYYYY)

From ‘Work Week (MMDDVYYY)

To Work Week (MMDDYYYY)

Celect Pay Campus(es), or blank for ALL

[
[
[
To Fay Date (MMDDYYYY) (
[
[
[
[

Select Supervisorns), or blank for ALL

Payroll > Reports > Year To Date Reports > HRS3450 - YTD Payroll Control
Listing

O Removed the CSV option. As a result, the CSV button was disabled on the report parameters page
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and the CSV icon was removed from the report.

Payroll > Reports > Year To Date Reports > Calendar Year To Date Report >
HRS3550 - School YTD Accrual Payroll Account Distr

O Corrected the program to properly generate the report. Previously, the report was blank.

Payroll > Reports > Payroll Information Reports > HRS1650 - Employee Salary
Information

O Corrected the report to only display the employee's current W-4 information from the Payroll >
Maintenance > Staff Job/Pay Data > Pay Info tab.

* |f the W-4 Withholding Certificate information is updated for the employee, then only the
new information is displayed.

e If the W-4 Withholding Certificate information is not updated for the employee, then the Nbr
Exempts field is displayed and the W4 Filing Status field is populated with the W-4 Marital
Status.

Personnel > Maintenance > Staff Demo > Demographic Information

O Modified the Legal (First, Middle, Last, Maiden) and Former (First, Middle, Last) name fields to
allow a maximum of 60 characters.

O Corrected the Document Attachments functionality to properly load the Document Options window
after clicking the Documents button. Previously, a blank window was displayed.

Personnel > Maintenance > Staff Demo > Responsibility

O Modified the program as follows to support the TSDS Staff Extension requirements:

e Removed all columns from the grid except the Year, Campus, Role ID, Service ID, Class ID,
and Grade Level.

e Removed the delete functionality (trashcan icon) from the grid.

* Added the Begin Date and End Date fields to enter the employee's begin and end dates in a
selected role ID.

e Bolded the Campus, Begin Date, and End Date field names to easily identify these fields as
TSDS PEIMS reporting elements.
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e Updated to only display responsibility records with a school year matching the School Year for
PEIMS Codes value.

Employae: [000ad1 - | | Rictricwe | | Chirectary |
DEMOGRAPHIC INFORMATION CREDENTIALS VERIFICATION INSURANCE SERWVICE RECORD RESPONSIBILITY
( Details  Year Campus Role D Service ID Class ID Grade Level )
3
N— "
School Year for PEIMS Codes: 2018
Campus sofsmdem= [ | Ty
wer: | IS E— -
oo (7] (7]
Service I 1 : '
o [ ] CrassTime ~ LN [E] e ]
s | 7] e S— ey o S
Min Wk 3
L == ESCrEsa: School District Employee hd
[ ] Drarys Wik 4 & 0
55 00-0000 | > (] mawee[ o ]

Personnel > Maintenance > Employment Info

O Modified the program as follows to support the TSDS Staff Extension requirements:

e Renamed the PEIMS Auxiliary Role ID field to Auxiliary Role ID.

e Added an Effective Date field next to the Auxiliary Role ID field to enter a begin date for the
employee's selected auxiliary role ID.

e Added an Effective Date field next to the Paraprofessional Certification check box to enter
a begin date for the employee's paraprofessional certification.

e Moved the Highly Qualified check box to display above the Auxiliary Role ID field.

e Bolded the Auxiliary Role ID, Paraprofessional Certification, and Effective Date field
names to easily identify these fields as TSDS PEIMS reporting elements.
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Employee: [CUUaS'_: } [ Retrieve I [ Directory

Original Emp. Date:

2 Active auxillary par

Latest Re-Employ Date:

Sub Type:
0 No Bachelor's v ik [ b
Retirement Date:
AT 00-00-0000 Employment Type: [}- Half-Time or more v]
e
= D LR L e D Retiree Employment Type: [ v]
NY Take Retiree Surcharge: E]
Highly Qualified:
(MCG MAINT. CUST. GROUNDS v i, 0
Year Round: O Effescines Do
. Auxiliary Role ID: [ v]
ERS Retiree Health Elig: E]
t Paraprofessional Certification: E] 00-00-0000

NY ERS Retiree Health Elig: D

Personnel > Tables > Job/Contract > Contract Class

[ Added validation to the Contract Class Code field to only allow numeric (0-9) and alpha (A-Z)
values to be saved. Also, to prevent duplicate contract class codes from being saved.

Personnel > Tables > Workday Calendars

O Corrected the program to prevent workday calendars with an invalid pay frequency from being
saved. As a result, workday calendars with invalid pay frequencies will not be displayed on the Copy
School Calendar and Delete School Calendar tabs.

Personnel > Utilities > Mass Update > Employee

O Corrected the issue that caused multiple records to be displayed for an employee when
incrementing the Prior Teaching Experience field and selecting multiple job codes. Now, only one
record per employee is displayed instead of one record per job code.

O Corrected the program to only enable the Job Code ellipsis if the Prior Teaching Experience
field is selected (enabled).

Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra
Duty Report

O Corrected the issue that prevented extra duty codes from being displayed in the Extra Duty Codes
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lookup for the Select Extra Duty Code(s), or blank for ALL parameter.

Personnel > Reports > User Created Reports

O Renamed the Active Only check box to Employed Only. If selected, employees who are currently
employed are included based on the current date, employment date, reemployment date, and term
date.

| | e |
Report Template
[ ] DF’JI;.: [ Retrieve ] [ Directory
Report Title
DEmplm‘ee Demographic
[DEmployes Nbr [ 5taff IDvsSH [OMaiden Name [JPhane Area Cd [OLast Change Date [JEmer Contact [JHispanic/Latins

Position Management > Maintenance > PMIS Position History

O Corrected the program to allow the deletion of a record (row) when applicable. If a record cannot be
deleted, an error message will be displayed.

Position Management > Maintenance > PMIS Supplement Modify

O Modified the program to automatically clear the Nbr Extra Days, Attached to Position, and
Billet fields when vacating a position that has a stipend with extra days.

O Modified the program to prevent Occupant data from being entered when the billet is 00000.

[ Added validation to clear the Date Inactivated and Reason Inactivated fields on the Date tab if
the position's original “saved” status was not /Inactive.
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Position Management > Maintenance > PMIS Change In Position

O Modified the program to automate and sync the termination dates in Position Management and
Personnel. If a termination date exists on the Personnel > Maintenance > Employment Info tab, it will
be automatically populated when processing a CIP. Or, if a termination date is entered on a CIP, it will
be automatically populated on the Personnel > Maintenance > Employment Info tab.

Position Management > Maintenance > PMIS Change In Position > Change In
Compensation

O Corrected the program to display all applicable supplements on the Payroll > Maintenance > Staff
Job/Pay Data > Distributions tab after processing a CIP. Previously, only some supplement records
were displayed.

O Corrected the issue where the remaining amount and remaining payments were being updated for
G type supplement positions after processing a CIP.

O Corrected the issue that prevented the pay rate, contract amount, and contract balance from being
updated for new G type supplement positions when there was a processed supplemental transmittal
for a prior month.

O Modified the program to use the TEA Base amount from the Personnel > Tables > Salaries > State
Minimum tab when calculating the state minimum salary for employees on a local annual pay concept
with a TRS position code of 02 or 05.

O Modified the annualized salary calculation to use 12, 24, or 26 (based on the pay frequency)
payments for comparison. Previously, the Max Pymts value was used.

Position Management > Maintenance > PMIS Change in Position > Non-Comp
Funding Changes

O Corrected the program to prevent error message “Remaining Payments must be greater than zero”
from being displayed when trying to process changes for pay type 3 employees with zero remaining
payments.

Position Management > Maintenance > PMIS Forecast Change

O Corrected the issue that caused the values in the Percent Day Employed and Percent Year
Employed fields to be ignored even though the Display Options to Ignore Pct of Day and Pct of
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Year for Position Records check box was not selected on the District Administration > Options >
Position Management page.

Position Management > Inquiry > PMIS Campus Supplement Position Inquiry

O Corrected the program to display a scrollbar as needed in order to view all data on the page.

Position Management > Utilities > Import Position Records

O Corrected the program to display error message “Invalid length for ACCT _PCT" instead of “Invalid
length for ACCT_AMT” when importing a CSV file with an invalid account percent.

Position Management > Utilities > Salary Simulation (NYR)

O Corrected the Forecast Account Distribution Journal by Salary Account report to list each individual
vacancy for a position number by account code and billet number. Previously, the report combined all
vacant positions in a single row.

Position Management > Utilities > Create Forecast Positions (NYR)

O Corrected the program to limit the warning messages displayed for the Total Pct of Day and/or
Total Pct of Year fields to P type positions. Previously, when creating forecast positions in NYR for
an employee with both a regular and supplement position, a warning indicating that the employee
exceeded 100% of the day was displayed. Now, the warning only displays if the employee has two or
more regular positions that exceed 100% of the day and the LEA does not have the Ignore % of Day
field selected for those positions. This warning does not apply to supplement positions.

Position Management > Reports > PMIS Reports > HRS8055 - Acct Code
Comparison - PMIS vs Payroll

O Corrected the account code comparison for supplement positions tied to extra duty codes. The
report now recognizes when a G type stipend is in Payroll and Position Management.
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Purchasing > Maintenance > Approve Requisition

O Modified the program to incorporate additional information to track requisition changes.

e |f a requisition with pending changes is being returned or skipped, a pop-up window with the
requisition details (Req Nbr, Vendor Nbr, and Vendor Name) and a message indicating that
there are pending changes is displayed.

e If a requisition without pending changes is being returned, a pop-up window with the requisition
details (Req Nbr, Vendor Nbr, and Vendor Name) is displayed.

* |f a requisition without pending changes is being skipped, a pop-up window is not displayed.

/

CareerPortal

CareerPortal > Job Dashboard

O Corrected the issue that prevented an applicant from viewing their submitted job applications.

CareerPortal > Posted Jobs

O Modified the error message that is displayed when a user tries to delete a job posting without the
appropriate rights.

v,

EmployeePortal
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EmployeePortal > Forgot Password

O Corrected the issue that prevented all necessary fields from being displayed on the page.
Previously, only the Social Security Number field was displayed.

EmployeePortal > Notifications

O Added the Mark All As Read button to the Notifications box and page allowing users to mark all
notifications as read.

02-09-2022 08:04:00 AM Wed: Leave Reguest from DEBRA DEAMNDA pending your approva...

Mark All As Read

Motifications

Wark 4l Az Read

g QE-09-2022 05:04:00 AM Wed: Lesve Request from DEBRA DEANDA pending your approval ax

EmployeePortal > Leave Requests

O Removed the filter only allowing leave requests created within 60 days of the current date to be
displayed under Unprocessed Leave Requests. Now, all unprocessed leave requests are displayed.

O Corrected the program error that occurred when selecting a leave type from the Type drop down.

EmployeePortal > Travel Reimbursement Requests > Travel Requests

O Corrected the program to reference the Next Available Travel Request Number in Finance
when submitting a new travel request.
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EmployeePortal > Travel Reimbursement Requests > Approve Travel Requests

O Corrected the issue that caused a travel request to remain on the page even after being approved
by the final approver. Also, corrected the issue that caused an additional workflow entry to be created
for the final approver.

O Modified the program to display the applicable error message when the final approver approves a
travel request but the Automatic PA Number Assignment field is not selected on the Finance >
Tables > District Finance Options > Finance Options tab. Previously, an error message was not
displayed and the travel request remained in a pending status.

Prior Release Notes for ASCENDER 6

Update: 6.0600

ASCENDER 6.0600

Release Date: 2/04/2022 ASCENDER Update: 6.0600

Finance > Tables > District Finance Options 2

[ Modified the Mileage Reimbursement Rate and New Mileage Reimbursement Rate fields to
allow three decimal places in the value. Now, the mileage rates are correctly displayed and calculated
on the following pages:

e Finance > Inquiry > Travel Reimbursement Inquiry
e EmployeePortal > Travel Reimbursement Requests > Travel Requests

Update: 6.0425

ASCENDER 6.0425

Release Date: 01/10/2022 ASCENDER Update: 6.0425
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Grants and Projects > Tables > SSA Grants > Payment Dates

O Corrected the issue that caused an error message to be displayed when trying to change and save
a payment date.

Grants and Projects > Maintenance > Member Grants > Object Maintenance

O Corrected the issue that caused an error message to be displayed when trying to save new grant
object data.

Update: 6.0405

ASCENDER 6.0405

Release Date: 12/14/2021 ASCENDER Update: 6.0405

Payroll > Reports > Quarterly/Annual Reports > HRS5100 - W-2 Forms

O Corrected the program to print the correct tax year (2021) on W-2 forms when the report is
generated with the For Tax Year > 2018, Include instructions (Y/N) or Print instructions only
(1) parameter set to N.

Update: 6.0400

ASCENDER 6.0400

Release Date: 12/10/2021 ASCENDER Update: 6.0400

O Corrected various pages in the following applications to only display the Provide Feedback link
once:

e Budget

Finance

Payroll

Personnel

Position Management
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e Purchasing

Finance > Maintenance > Vendor Information > Vendor Miscellaneous

O Modified the Copy from Payroll button functionality to use the Finance bank code instead of the
Payroll bank code.

e |f the bank code does not exist in Finance, an error message is displayed prompting the user to
add a new bank code in Finance.

* If the employee does not have a bank record in Payroll, an error message is displayed informing
the user.

O Corrected the Copy from Payroll button to only display if the vendor and employee SSN records
are valid and match.

O Corrected the program to display the vendor number and name in the Vendor field at all times.
Previously, the vendor number no longer displayed after changes were saved to other fields on the

page.

Finance > Maintenance > Create Chart of Accounts

O Corrected the issue that prevented account codes with a 99 function code and an 8XXX object code
from being created.

Finance > Maintenance > Postings > Check Processing-PA & Check Processing-
PO

O Corrected the trashcan icon to remain displayed when adding a new line item.

Finance > Maintenance > Postings > Journal Actual

O Added the Ignore for Grants and Projects check box to the Duplicate )V pop-up window to
ignore JV entries for the Grants and Projects application. This check box is only enabled if duplicating
an Actual JV transaction.

Finance > Inquiry > GL Inquiry > GL Inquiry
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O Corrected transaction and balance issues within the spyglass pop-up window.

Finance > Inquiry > GL Inquiry > GL Account Summary

O Corrected the spelling of Revenue in the Estimated and Realized Revenue column headings on the
report preview and PDF.

Finance > Utilities > Out of Balance Correction

O Corrected the program to prevent incorrect balances to be calculated and saved.

Finance > Utilities > Positive Pay Export

O Corrected the export to prevent the value in the Vendor Name field from being used as the Pay
To value if a DBA or Remittance Name and Address is available when using the Pending Payables and
the PO/PA processes together. Previously, a single check transaction was separated into two
transactions and although the check numbers were the same, the Pending Payable transaction
amounts were populated with the value from the Vendor Name field on the Vendor Information page
and the other transaction amounts processed through PO/PA were populated with the value from the
Vendor Remittance field.

Finance > Reports > Finance Reports > Vendor/Purchase Order Reports >
FIN2100 - 1099 Forms

O Per IRS requirements, updated the 1099-MISC/1099-NEC forms/instructions and all 1099-
MISC/1099-NEC functionality to support the 2021 tax year.

Grants and Projects > Tables > Manage Users

O Corrected the Module column in the database to display GRT2160 Manage Users when adding or
updating grant type information for a user.

Grants and Projects > Maintenance > Member Grants > Grant Maintenance
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[ Corrected various user interface issues to improve the user experience.

O Corrected the Module column in the database to display GRT3010 Mbr Grant Maint for deleted
transactions.

Grants and Projects > Maintenance > Approval Dashboard

O Corrected the Module column in the database to display GRT3020 Approval Dashboard for
approved/returned transactions.

Payroll > Tables > District EP Options

O Corrected the issue that prevented changes to the W-2 Information message field from being
successfully saved and displayed in EmployeePortal.

Payroll > Maintenance > Calendar YTD Data > Calendar YTD

O Added the following FFCRA Payment fields for the 2021 calendar year:

e EPSLA Regular
e EPSLA Two-Thirds
e EFMLEA

Payroll > Maintenance > Calendar YTD Data > W2 Inquiry
O Added the following FFCRA Payment fields for the 2021 calendar year:
e EPSLA Regular

e EPSLA Two-Thirds
e EFMLEA

Payroll > Next Year > Copy CYR Staff to NYR & Copy NYR Staff to CYR

[0 Added the TRS Retiree Exception field to the process and preview report.
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Payroll > Payroll Processing > TRS Processing > Payroll History

O Corrected the program to retrieve pay date information for the TRS month instead of the pay date
month.

Payroll > Utilities > Import HR tables from Database Tables

O Added a new WorkJournal Comparison Report to display a list of WorkJournal records that were
imported but no longer exist as payroll transmittals due to the import.

Payroll > Utilities > Import WorkJournal Requests

O Modified the program to prevent WorkJournal request records from being selected if the job code no
longer exists on the employee's master job record.

Payroll > Reports

O Corrected the email content (subject/body) to mirror the letter case entered by the user. Previously,
all letters were converted to uppercase.

e HRS1250 - Employee Data Listing

HRS1650 - Employee Salary Information
HRS2050 - Proof List of Payroll Transactions
HRS2500 - Wage and Earning Statement
HRS2600 - Employee Substitute Report
HRS3500 - YTD Wage and Earning Statements
HRS6400 - Salary Verification Report

Payroll > Reports > Personnel Reports

[ Added the Creditable Year of Service field to the following reports:

e HRS1100 - Employee Verification
e HRS1250 - Employee Data Listing
e HRS1650 - Employee Salary Information
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Payroll > Reports > Quarterly/Annual Reports > HRS5100 - W-2 Forms

O Per IRS requirements, updated the W-2 form/instructions and all W-2 functionality to support the
2021 tax year.

Payroll > Reports > User Created Report

[0 Added the Creditable Year of Service check box to the Employment section.
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Personnel

O Added the ability to import data into the Personnel application through an automated process.
Instructions for this process are located on the TCC Technical Documentation > ASCENDER Personnel
Import page in the ASCENDER Wiki.

Personnel > Tables > WorkJournal > Options

O Modified the program to display the Unsaved Data Warning pop-up window when applicable.

O Corrected the issue that caused the time conversion table to inadvertently default to pay frequency
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4 even though it was not created in pay frequency 4. This issue occurred in databases with only one
pay frequency.

Personnel > Tables > Workjournal > Admin

O Modified the Unsaved Data Warning pop-up window to set the cursor focus on the Cancel button.

Personnel > Maintenance > Staff Demo > Credentials

[ Added the Teacher Incentive Allotment Designation section, which includes the following
allotment codes and descriptions:

e 01 Active National Board Certified Teacher
e 02 Active Teacher Incentive Allotment Designation
e 03 LEA Submitted Designation Pending

Emplopee: (000006 : ADAMS, ADAME. ] | Retrieve | | Directary | | Dacuments |

DEMOGRAPHIC INFORMATION CREDENTIALS VERIFICATION INSURANCE SERVICE RECORD RESPONSIBILITY

macher incertsve Allotment Designation \
-

Delete  Allotment Code

Education
P

Dielete College “Year Major Minor Diegres

[ B [5'.-C-Z.‘.EEL|‘.C—.'>EJ:ALC]Q [ 13

Personnel > Maintenance > Employment Info

O Added the Creditable Year of Service check box to the Years Experience section.

O Corrected the page to only display the applicable scroll bars.

Personnel > Self-Service > Pending by Alternate

O Corrected the issue that caused an error to occur when an employee submitted changes to their
phone number via EmployeePortal.
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Personnel > Utilities > Mass Update > Employee

( Added the Creditable Year of Service field under Reset to reset the employee's creditable year
of service. Also, added the Creditable Year of Service column to the Employee Mass Update
Report.

Parameters

Pay Status: (@ Active () Inactive (C)Both

i [AlL ] Primary Campus: [Al[ v] Payoff Date: [:]

ay Type: w

i e (i = Pay Campus: (AL v Frequency: (Bweekly CVR
Contract Begin Date: S .

Accrual Code: [.-'—‘«LL V] st [ v] Salary Concept [All
Contract End Date: [ v] Extract ID: [

Contract Months: :]

Employee Nbr: :]
Prior ¥r Emp Date:| 00-00-0000

EMPLOYEE
Reset Update Experience Modify E
(] Extract 1D [ ¥ From To
[ Unemployment Eligibitty (Vo) (] Tete! Prof) Experience Meatk I ]
(ICESA Report] o If Employment Date < (=) Zip Code: | ]
(0] Take Retiree Surcharge  [Ves  +| (] District [Prof) Experience
E] MY Take Ret Surchg |—v| If Employment Date = :]

D Employment Type [] District {Non-Prof) Experience
[:] Retiree Employment Type w If Employment Date < :]

{ E] Creditable Year of Service | Yes v D L] Yol Brotl=Spencsice
- If Employment Date < :]

e W L =

Personnel > Utilities > Mass Delete > Employee Data

O Modified the program to include the Teacher Incentive Allotment designation in the mass deletion
process.

Personnel > Utilities > ACA 1094/1095 Correction/Replacement

O Per IRS requirements, updated the utility to support the 2021 tax year.
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O Removed transmitter control code (TCC) validation from the ACA file creation process.

Personnel > Reports > Personnel Reports

[J Added the Creditable Year of Service field to the following reports:

e HRS1100 - Employee Verification
e HRS1250 - Employee Data Listing
e HRS1650 - Employee Salary Information

Personnel > Reports > Personnel Reports > HRS1750 - Teacher Incentive
Allotment Designation Report

O Added this report to provide a list of employees with their Teacher Incentive Allotment Designation
codes and descriptions.

| Peiew || PDF || csv | [ crearopions |

Personnel Reports HRS1750 - Teacher Incentive Allotment Designation Report
HRS100 - Roster of Personnel -

HRS51050 - Employvee Birthday List .
HRES1100 - Employee Verification Report Parameter Description Value
HRS120 - Federal EEQLC Report .
HRS51250 - Employee Data Listing Sort by Alpha (A), Pay Campus (C). Primary Campus P} | J
HRS 1400 - Teacher Service Record ot 1A T maete (1] o b .
HRS1450 - Employee Mailing Labels Pay Status Active (A), Inactive (1], or blank for ALL [ ]
HRS1500 - Employes Education Report ! ,
HRS 1550 - Mew Hire Repart Pay Type 1-4, Exclude Subs (E], or blank for ALL [ ]
HRS 1500 - Certification Report = - o
Select Pay C s(es), or blank for ALL
HRS51650 - Employves Salary Information S R, R [ ]
HESL700 - odal Security Mumber Verfication Select Primary Campus(es), or blank for ALL [ ]
HRS1750 - Teacher Incentive Allotment Designsticn Beport
Select Employes(s), or blank for ALL [ ]
Select Frequency [ ]

Personnel > Reports > Payroll Information Reports > HRS5250 - 1095-B Forms

O Per IRS requirements, updated the 1095-B form/instructions and all 1095-B functionality to support
the 2021 tax year.

O Removed transmitter control code (TCC) validation from the ACA file creation process.
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Personnel > Reports > Payroll Information Reports > HRS5255 - 1095-C Forms

O Per IRS requirements, updated the 1095-C form/instructions and all 1095-C functionality to support
the 2021 tax year.

O Removed transmitter control code (TCC) validation from the ACA file creation process.

Personnel > Reports > TRS Reports

O Corrected the issue that prevented the following reports from being generated:

e HRS4300 - Health Insurance Participation Report
e HRS8900 - Employee Data (ED)
e HRS8905 - Regular Payroll (RP)

Personnel > Reports > User Created Reports > Personnel

[J Added the Creditable Year of Service check box to the Employment section.

Report Template

[ | OPubte ’ Retriore ” oD

Repart Title

( J

Employes Mbr :] H D Active Employees Only

D Employment

D_a ke Retiree Surcharge |:|Terr’-n5t50'1 Reason

|:|Terr"'15ron Rezson Descr

= D-‘\" Take Retiree Surcharge
[JRetirement Date [JExtract D

[ Termination Date [Fingerprint Status Owre 22 Health Elig
DE::tence ave Begin D="1ge rprint Extract Date DET!:.:J\-'"ent Type
[ Centract Year [(Extend=d Leave End [JFingerprint Date [ Retiree Employment Type [ Paraprofessional Certification

[ Grades Taught

Purchasing > Inquiry > GL Inquiry > GL Account Summary

O Corrected the spelling of Revenue in the Estimated and Realized Revenue column headings on the
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report preview and PDF.

Purchasing > Maintenance > Create/Modify Requisition

O Modified the Refresh Totals, Calculate Amounts, and Calculate Percent links to correctly
calculate amounts and percentages when creating a requisition that has one line item with multiple
accounts. This change is also effective for the Uniform Account Distribution.

Purchasing > Reports

O Corrected the email content (subject/body) to mirror the letter case entered by the user. Previously,
all letters were converted to uppercase.

e REQ1450 - Print Purchase Orders
e REQ1500 - Reprint Purchase Orders
e REQ2000 - Request for Quotation Report

Warehouse > Reports > Warehouse Reports > BWH1450 - Print Purchase Order
Form &
BWH1500 - Reprint Purchase Order Form

O Corrected the PO Signature button pop-up window to display and function as intended.

v,

EmployeePortal

Release Date: 12/10/2021 ASCENDER Update: 6.0400

O Modified the program to ensure that the applicable Employee/Supervisor reminder emails are sent
daily around 6:00 AM.
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EmployeePortal > Inquiry > Calendar Year to Date & W-2 Information

O Added the following FFCRA Payment fields for the 2021 calendar year:

e EPSL1 (Emergency Paid Sick Leave Act (EPSLA) regular rate)
e EPSL2 (Emergency Paid Sick Leave Act (EPSLA) two-thirds rate)
e EFMLEA (Emergency Family and Medical Leave Expansion Act)

NOTE: If any of these amounts are greater than zero, the field and amount are displayed in Box 14 on
the employee's W-2.

EmployeePortal > Inquiry > W-2 Information

O Per IRS requirements, updated the W-2 form/instructions and all W-2 functionality to support the
2021 tax year.

EmployeePortal > Inquiry > 1095 Information

O Per IRS requirements, updated the 1095-B/1095-C forms/instructions and all 1095-B/1095-C
functionality to support the 2021 tax year.

EmployeePortal > Leave Requests

O Modified leave requests to display as follows:

e Leave requests with an Approved or Pending Approval status are displayed on the employee
homepage calendar and the Leave Requests page, and can be edited.

e Leave requests with an Import into Payroll or Processed status are displayed on the employee
homepage calendar and the Leave Requests page, and cannot be edited.

Note: All employee leave requests in the above statuses are displayed as read-only on the
supervisor's homepage calendar.

O Added the Outlook Calendar and Google Calendar links to leave approval emails allowing
employees to add approved leave requests as Outlook/Google calendar events.
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O Corrected the program to prevent duplicate leave requests from being displayed under
Unprocessed Leave Requests and on the homepage calendar.

EmployeePortal > Travel Reimbursement Requests > Travel Requests

O Added maximum length limits to various fields.

O Corrected the issue that caused all inline error messages to be displayed upon accessing the page.

EmployeePortal > Travel Reimbursement Requests > Approve Travel Requests

O Corrected various functionality and user interface issues including the select all check box and the
document attachments icon to improve the user experience.

/

)

MemberPortal

Release Date: 12/10/2021 ASCENDER Update: 6.0400

MemberPortal > Login

O Corrected the Oops error page to display MemberPortal instead of EmployeePortal.

MemberPortal > Forgot Password

[ Modified the functionality and user interface to meet ASCENDER portal standards.
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MemberPortal > Budget Revision Request & Reimbursement Request

O Corrected the program to ensure that all approvers in an approval path receive automated email
notifications for pending budget or reimbursement requests.

O Corrected the Module column in the database to display the originating page name for submitted
requests.

MemberPortal > Manage Users

O Corrected various user interface issues in the Unsaved Data Warning pop-up window.

O Corrected the Module column in the database to display GRT2160 Manage Users when adding or
updating grant type information for a user.

Update: 6.0350

ASCENDER 6.0350

Release Date: 11/12/21 ASCENDER Update: 6.0350

Payroll > Payroll Processing > TRS Processing > Extract

O Corrected the issue that prevented the extract from being processed. This issue occurred if the
logged-on user had a work email address listed on the Personnel > Maintenance > Staff Demo >
Demographic Information or District Administration > Maintenance > Non-Employee pages.

Update: 6.0200

ASCENDER 6.0200

Release Date: 9/28/21 ASCENDER Update: 6.0200

O Updated the color contrast across all ASCENDER Enterprise applications for ease of readability.
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O Modified the portals to meet WCAG 2.0AA accessibility standards.

e CareerPortal
e EmployeePortal
e MemberPortal

Accounts Receivable > Maintenance > Credit Memo

O Corrected the program to properly change an invoice status from open to closed when a credit
memo is applied to zero out the invoice. Previously, the invoice status remained open and was still
displayed on the Customer Statement and Detail Aging reports.

Finance > Utilities > Fiscal Year Processing

O Modified the Out of Balance Correction utility and the FIN1600 - Batch Process Balance Error Listing
to correctly report out of balances.

Payroll > Payroll Processing

O Corrected the issue that caused the Retiree Pension Gross to be updated with an incorrect amount.

Payroll > Payroll Processing > TRS Processing > Adjustment Days

[ Added the Retiree Employment Type field. This field is only enabled for ER records. The drop
down contains the following values:

¢ B - Non-Profit Tutor Substitute

e C - Combination of Substitute and Half-time or less
e E - Surge Personnel

e F-Full-Time

e H - Half-time or less

e N - Non-Profit Tutor Half Time or Less

e S - Substitute

o T - Non-Profit Tutor Full Time
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ADIUSTMENT DAYS PAYROLL HISTORY EXTRACT MAINTENANCE CREATE FILES INTERFACE PURGE

Extract

Maintenance

Employee: (000003 : ACOSTA, ABELINDA LEROY ] startDate: [ - - | [ Retrieve
. g —
| Delete Type TRS Pos Cd Retiree Employment Type Y Begin Adj Date\ End Adj Date Mbr Days 4|
C. [ ER v] [ 01 Professional staff [ ] [ - - ] {
) /0 B Mon-Profit Tutor Substitute

C Combination of Substitute and Half-Time or less
E Surge Personnel
F Full-Time

H Half-Time or less

N Non-Profit Tutor Half Time or Less
\ S Substitute

T Mon-Profit Tutor Full Time
o

Payroll > Payroll Processing > TRS Processing > Extract

O Modified the program to allow multiple ER20 records to be extracted for an employee based on the

value in the TRS Retiree Exception field in the job history. ER20 records will be extracted per

Primary Job and per Retiree Exception. Any extra duty pay (XTRA job) that is not attached to the job

with the Retiree Exception will be reported with the Primary Job.

Payroll > Payroll Processing > TRS Processing > Maintenance

O Modified the program to allow multiple ER20, ER25, and ER27 records to be entered and saved for

an employee.

O Added the following options to the Retiree Employment Type drop down for ER20, ER25, and
ER27 records:

¢ B - Non-Profit Tutor Substitute

e E - Surge Personnel

e N - Non-Profit Tutor Half Time or Less
e T - Non-Profit Tutor Full Time

Payroll > Next Year > Copy NYR Tables to CYR
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O Corrected the issue that prevented some tables from being copied over even though they were
selected.

Payroll > Utilities > TRS Maintenance > Employment After Retirement (ER)

O Modified the program to allow multiple ER20, ER25, and ER27 records to be entered and saved for
an employee.

[J Added the following options to the Retiree Employment Type drop down for ER20, ER25, and
ER27 records:

e B - Non-Profit Tutor Substitute

e E - Surge Personnel

e N - Non-Profit Tutor Half Time or Less
e T - Non-Profit Tutor Full Time

Payroll > Utilities > Import WorkJournal Requests

O Corrected overtime and straight overtime calculations for pay type 2 employees.

Payroll > Reports > Personnel Reports > HRS1250 - Employee Data Listing

O Added the Retiree Exception field to the State Info section on the report.
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Employee Data Listing Program: HRS1250
ISD Page:2of 3
Frequency- b
M
Job Information

— Calendar Info — State Info

Calendar: (4 =taff test TRS Year:

Begin Date: 07-01-2021 State Step: 20

End Date: 06-30-2022 | | TRS Mbr Posz: 02 - Teacher. librarian

Payoff Date 06-30-2022 | | ¥'r= in Career Ladder: 0

Retiree Exception: B - Non-Profit Tutor Subshtute

— Contract Info — Accrual Info

Contract Amt: 90,000.00 | | Accrue Code: A

Contract Balance: 20,000.00 | | Accrual Rate: 412 544

Mbr of Annual Pymts 2

Remaining Pymts 24 | — State Min Salary

Nbr of Months in Contract: 10 | | Percent Assigned:  25%

State Min.Salary: .00

— [Daily Rate — Standard Pay Rate

Daily Rate of Fay: 412 844 Fay Rate: 3.750.00

Payroll > Reports > Personnel Reports > HRS1650 - Employee Salary

Information

O Added the Retiree Excptn (Retiree Exception) field to the Job report.

Employes Salary Information Program: HRS1650
15D Page: 1 of 1
Emp Nbr: 000452 Yr= Expenence Distnict Frequency- .
SSEN: 226-02-2408 s Expenence Total: Pay Campus: oo
DOE: [3-26-15946 Y'r= Prof Exper Distnict: 01 Primary Campus: oo
Degree: 7 - Bachelor's ¥z Prof Exper Total: 11 w4 Filing Status: b
Latest Re-Emp Date: BExdract |D: Mbr Exempts: 0
oo Retirement Date: Work Email:
0 W4 Nbr Other Dependents: [ W4 Other Exemptions: 500
W4 Other Deductions:  5.00
Job Information
Payoff Date:
jte: (08-01-2027 # Months in Contract: 10 TRS Status: 5 - Retired
b (08-30-2022 # Days in Contract: ] B0 03 - Support si=ff
Armount £10,000.00 # of Annual Pronis: 1E|Hﬂlime Bapin: T - Non-Profit Tutor Full
Time
Balance: £10,000 00 Remaining Pymis: 10 FICA Ehgibility: M - Subject to medicare
E;Days: Hourly Rate: 50,00 WC Code:
: 0 'Wholly Sep Ami: £0.00
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Payroll > Reports > TRS Reports > HRS8910 - Employment After Retirement (ER)

O Modified all reports (ER20, ER25, and ER27) to include the TRS Retiree Exception codes and
descriptions.

O Corrected the issue that prevented the report from being generated.

Payroll > Reports > User Created Reports

0 Added the Retiree Exception check box to the Job Information section.

DJ ob Information

[JYob Code [JPercent Assigned [JPayoff Date [OJPay Grade [ Daily Rate [JOvertime Eligible

[JJab Descr [JDepartment [CJMbr Days Employed [JPay Step [JHrly Rate [ Overtime Rate

[ Primary Job [JPay Type [JNbr ntract [JPay Schedule [JPayRate rs/Day

[JPrim Campus [JCalendar Code [OLec t Days [5tate Step [(JBase Annual

[JCampus Name [JContract Begin Dt [CJMbr of Annual Pymts [JContract Total [JAcerual Cd ay

[:] Mbr Mon Contr [:]Con:ra': End Dt [:] Remaining Pymts Contact Balance [:] Accrual Rate E]\.."a:a ~t Pasition

E]‘ffs of Job Exper E]‘r'rs n Career Ladder E]'\"'.!'(l'_.-' Hrs Sched E]'-.-‘\-'ﬂ:. ¥ Sep Amit E]Reg Hrs Worked

D Retiree Exception

Personnel > Tables > Job/Contract > Job Codes

O Corrected the issue that prevented the selected Time Option code description from being
displayed on the report.

Personnel > Tables > WorkJournal

O Corrected the functionality of the Enable WorkJournal Time for Pay Types options. Previously,
these options were not functioning as intended, and all pay type 2 and 3 employees were available
for WorkJournal purposes in EmployeePortal.

Personnel > Tables > WorkJournal > Options

O Corrected the program to remain in the same frequency when time conversion table updates are
saved and errors are generated.
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[ Corrected various user interface issues to improve the user experience.

Personnel > Reports > Personnel Reports > HRS1250 - Employee Data Listing

O Added the Retiree Exception field to the State Info section on the report.

Personnel > Reports > Personnel Reports > HRS1650 - Employee Salary
Information

[0 Added the Retiree Excptn (Retiree Exception) field to the Job report.

v,

EmployeePortal

Release Date: 9/28/21 ASCENDER Update: 6.0200

[ Updated the background image on the Login page.

O Modified the program to automatically sync WorkJournal and Leave workflows for Alternate
Approvers.

EmployeePortal > Homepage Calendar

O Modified the program to disable the WorkJournal menu and the WorkJournal button on the Add
Request Type pop-up window when the WorkJournal option is unselected under Enable on the
Payroll > Tables > District EP Options > EmployeePortal Options page.

EmployeePortal > Travel Requests
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O Corrected the program to reference the account codes tied to a submitted travel request in order to
determine the appropriate approval path.

O Removed the Location Locking functionality for extended travel requests.

O Corrected the status (enabled/disabled) of the Retrieve button when entering and clearing Date
fields.

EmployeePortal > Workjournal

O Corrected the program to automatically retrieve data on the page when a value is selected in the
Pay Frequency and Work Week Start Date fields. If the user manually enters the Work Week
Start Date, they must tab out of the field in order to retrieve data on the page.

O Corrected the program to prevent users from saving overlapping time entries. For example, if a
user saves a time entry from 8:00 AM to 4:00 PM, then another time entry can only be saved if it is
before 8:00 AM or after 4:00 PM.

O Corrected the issue that caused the total hours worked calculation to be incorrect when the
Percent of Hour was not set up for 100% in the Time Conversion Table on the Personnel > Tables >
WorkJournal > Options tab.

O Corrected the program to display the Total Hours field on the Weekly Totals row after the Leave
field.

Update: 6.0105

/

EmployeePortal
Release Date: 9/12/21 ASCENDER Update: 6.0105

EmployeePortal > Login

O Corrected the issue that prevented some employees from creating a new account or logging in to
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their existing account.

Update: 6.0100

ASCENDER

Release Date: 9/3/21 ASCENDER Update: 6.0100

Business Known Issues

O Modified the program to create a End User License Agreement (EULA) for ASCENDER. Users must
accept the agreement in order to proceed with account creation and/or first log in and on an annual
basis.

e ParentPortal

e StudentPortal

e TeacherPortal

e EmployeePortal

o CareerPortal

e MemberPortal

e ASCENDER Enterprise

Approval Summary

O Added pending approvals from the Grants and Projects > Maintenance > Approval Dashboard page
to the Approval Summary list.
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Approval Summary
# Pending IDVFreq Approval Typ
0 C Finance = Af Budget Amendment
0 Fi Finance = Ap e Budget Amendment
] Grants & Projects = Approval Dashboard
0 Cfd Payroll = Approve CIP Transaction
1 /5 Payroll = Approve CIP Transaction
0 /6 Payroll = Approve CIP Transzaction
0 Payroll = Self-Service Payroll Approval
0 Personnel > Self-Service Demographic Approval
0 Cf4 Position Management = PMIS Payroll Bejections
0 C/5 Position Management = PMIS Payroll Rejections
0 C/6 Position Management = PMIS Payroll Rejections
0 Purchasing = Approve Bundle Requisitions
0 Purchasing = Approve Requisitions
0 Purchasing = Mext Year Approve Requisitions
0 1 Warehouse > Approve Inventory Restock Requisitions
0 1 Warehouse > Approve Warehouse Requisitions

Grants and Projects > Tables > Manage Users

O Corrected the issue where changes were made to an existing user's Member or Grant Type access,
and then when the user tried to log on to MemberPortal, they were prompted to change their
password even though no password changes were made.

Grants and Projects > Maintenance > Member Grants > Grant Maintenance

O Added validation for submitting a reimbursement request with zero values for final approval.

O Corrected an issue where a check was voided and reposted and the new final reimbursement check
was set to a Pending status; however, instead of restricting new reimbursements from being
submitted, the Grant Maintenance record reopened allowing new reimbursement requests to be
submitted.

O Corrected the issue that required users to first click the Save button and then the Submit button
instead of just clicking the Submit button to submit a budget revision or budget adjustment request.

[ Added the Cancel Trans column under the Transactions section allowing users to click the
trashcan icon to cancel applicable transactions. Only transactions with a Pending, Returned, or Saved
status can be canceled.
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Reimbursement Fanal
Trans |Detail Doc ¥ Date Type Status Budget Arrount Amount Check Nbr Payment Date Report
08-19-2021 Budget Adjustment Posted 3,000.00 0.00
08-19-2021 Budget Adjustment Posted 5.100.00 0.00
08-19-2021 Budget Adustment Saved 656.00 0.00

Grants and Projects > Utilities > Copy Payment Dates

0 Added this page to copy payment dates from one grant type to another grant type. Payment
information can be copied to multiple grant types.

A Utilities > Copy Payment Dates ~ Grants And Projects B§

Copy Pay Dates to Grant Types

Copy Pay Dates from Grant Type
Geant Type: [ ']i atriay | Select All
£ ] A Grant Tyee Description

Cut Off Date Payment Date
Mo Rows

Grants And Projects > Reports > SSA Grants Reports

O Enabled the Preview button for all SSA Grants Reports to allow users to preview a report prior to
downloading the Excel or PDF file.

T EESoi Gl Bavodt v Grants And Projects 53

[ peview || PDF | | csv | [ clearoptions |

Grants And Projects > Reports > SSA Grants Reports > GP1000 - Grant Summary
Status Report

O Modified the Grant Year (YYYY) or blank for ALL parameter to only accept a four-digit numeric
value.

O Modified the sorting on the PDF file to match the sorting on the Excel file by sorting from newest to
oldest when sorting by Year. Previously, the PDF sorted from oldest to newest.
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Grants And Projects > Reports > SSA Grants Reports > GP1100 - Grant Payment
Transaction Report

O Corrected various user interface issues to improve the user experience.

O Corrected the report to generate the appropriate error when the From Date parameter value is
greater than the To Date parameter value.

O Modified the approval date (Appr Date) format (MM-DD-YYYY) to match on both the Excel and PDF
files.

Grants and Projects > Reports > SSA Grant Reports > GP1200 - Past Final Date
Without Final Report

O Corrected various user interface issues to improve the user experience.

O Modified the CSV file to display the complete Grant Year column heading. Previously, only Year
was displayed.

O Corrected the document Help path for GP1200 - Past Final Date Without Final Report to link to the
Production environment.

Finance > Inquiry > Travel Reimbursement Inquiry

O Added this page to retrieve a listing of travel reimbursement requests for each vendor. Only
requests that have been processed in Finance are displayed.

‘n Inquiry > Travel Reimbursement Inquiry v Finance ==

| Retiieve | Filg

Reguest Dates

Travel Reguest Nbr: ] Vendor: |

From - {00-00-0000 ] To:(00-00-0000

Travel Information

Details Travel req Mbr Vendor Date Requested Request Total Purpose Check Mumber

Mo Rows
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Finance > Maintenance > Check Processing > Void Check

O Modified the program to properly handle voided reimbursement check transactions with the Final
Report check box selected from the Grants and Projects application.

Payroll > Maintenance > Staff Job/Pay Data > Job Info

O Added the Retiree Exception field to select the applicable retiree exception code. This field is
used in conjunction with the Employment Type and Take Retiree Surcharge fields to determine
whether or not to calculate a retiree surcharge for the employee. A value cannot be saved if the
employee's TRS Status is set to 1 Eligible on the Pay Info tab. This field is disabled for XTRA jobs.
The drop down contains the following values:

E Surge Personnel

B Non-Profit Tutor Substitute

N Non-Profit Tutor Half Time or Less
T Non-Profit Tutor Full Time

A Maintenance > Staff Job/Pay Data ~ Payroll 53

Year: C Fréquency. &
Employee: (000113 - BROWN, BILLY E ]
(N}
Daily Rate: Contract Total £ of Days Empld 2 Davys OFf r__] Vacant Job:
Pay Rate: Contract Total £ Annual Pymts Payoff Date L—] Wihly Hrs Schec I’_]
Fieg Hrs Worked OV Elig D OWTM Rate Hily Rate Exempt Status D EEQC ~
State Info
1 o L'_] ¥rs in Career Ladder . TRS Yeal 0 TRS Member Pos: 09 Summer School Whally A [
b F 3 PO o Plaat s 1
A ﬁ Foundat X % |.— ¥ Fof day Retiree
ala Draily Rate Azsigned e Empld Exception
Calendar/Local Info
s C (FEanania ] ¥ of Days fmpld
| = w3 alda

Payroll > Maintenance > Leave Account Transaction > Staff Leave Maint

O Corrected the program error that occurred when attempting to enter leave for an employee without
assigned leave codes. Now, an informational error message is displayed instead.
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Payroll > Payroll Processing > Run Payroll

O Modified payroll calculations to properly handle TRS Retiree Employment exception processing.

[ Modified the program to allow the maximum dependent care deduction to be $10,500 for calendar
year 2021.

Payroll > Payroll Processing > Payroll Adjustments > Check Issue

O Modified the program to allow the maximum dependent care deduction to be $10,500 for calendar
year 2021.

Payroll > Utilities > Import WorkJournal Requests

O Added this page to import approved employee WorkJournal requests for each of the work weeks in
the selected pay period that were submitted through EmployeePortal. This process creates a pay
transmittal to be processed by payroll.

M Utiltios > Impart Worklowmal Requests ~ Payroll 5§

Year: C Frequency: §

O & Status Eme Mbx Eirst Hams: biididie Mams Last Hamg Generation lob Codg Erimary. Camous Dot Bepoin Work Week [t Total Thms: Suptryisos

Personnel > Tables > Salaries > Extra Duty & Salaries NYR > Extra Duty

O Modified the program to only allow the Use for ST OT check box to be enabled for S-type extra
duty codes. In addition, this check box can only be selected for one S-type extra duty code.

Personnel > Tables > WorkJournal > Options

O Corrected various user interface issues to improve the user experience.
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Personnel > Tables > Workjournal > Admin

O Corrected various user interface issues to improve the user experience.

v,

EmployeePortal

Release Date: 9/3/21 ASCENDER Update: 6.0100

NEW: Work]Journal

Workjournal

The new WorkJournal feature allows pay type 2 and 3 employees to create and submit timesheet
entries for time (hours) worked on a specific day. This feature offers a summary/detailed view of
WorkJournal requests to both employees and supervisors. The following functionality was added:

EmployeePortal > Workjournal

O Added this page to allow employees to create and submit timesheet entries for time (hours) worked
on a specific day.

EmployeePortal > Supervisor > Approve Workjournal

O Added this page to allow supervisors to approve/return employee Workjournal requests.

EmployeePortal > Supervisor > Calendar

O Modified the page to display the logged-on supervisor's employees' WorkJournal entries (total hours
worked) for each day.
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EmployeePortal > Login

O Corrected the issue that prevented some users with multiple pay frequencies in the current year
from being able to log on to EmployeePortal.

EmployeePortal > Homepage Calendar

O Added the WorkJournal button to the Add Request Type pop-window to allow users to create a
WorkJournal request.

Add Request Type

WaorkJournal

O Modified the program to display the total hours worked for each WorkJournal entry on a day, up to
three entries. If an entry is more than five hours for a job code that has an automatic lunch set up in
Personnel, the amount of time (in minutes) is automatically deducted from the total time worked for
that job code on that work day.

EmployeePortal > Travel Requests

O Corrected the program to display all validation errors at the same time upon clicking the Save
button. This allows the user to correct all errors in one instance.

O Corrected the issue that caused blank mileage start and end times to be recorded and displayed as
12:00 AM when the Require Start/End Times check box was unselected on the Finance > Tables >
District Finance Options 2 page.

EmployeePortal > Approve Travel Requests
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[ Corrected the sequence of the cursor focus when tabbing through the page.

MemberPortal

Release Date: 9/3/21 ASCENDER Update: 6.0100

MemberPortal > Login

O Modified the program to require the user to reset their password upon expiration.

O Corrected the Help button to display the question mark icon to the left of the word Help instead of
below.

O Corrected the issue where changes were made to an existing user's Member or Grant Type access,
and then when the user tried to log on to MemberPortal, they were prompted to change their
password even though no password changes were made.

MemberPortal > Grant List

O Corrected the Document Attachments functionality in the transaction details pop-up window to
display/hide the paper clip icon accordingly as documents are added/removed.

MemberPortal > Budget Revision Request

O Corrected various user interface issues to improve the user experience.

O Corrected the Grant ID lookup to automatically refresh the page and retrieve the data for the
selected grant ID.

MemberPortal > Reimbursement Request

O Corrected various user interface issues to improve the user experience.

O Corrected the Grant ID lookup to automatically refresh the page and retrieve the data for the
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selected grant ID.

MemberPortal > Manage Users

O Corrected various user interface issues to improve the user experience.

O Corrected the issue where changes were made to an existing user's Member or Grant Type access,
and then when the user tried to log on to MemberPortal, they were prompted to change their
password even though no password changes were made.

2026/02/08 19:27 46 ASCENDER Business Release Notes



RN

ASCENDER.

ELEVATING TECHNOLOGY SOLUTIONS

Back Cover

2026/02/08 19:27 47 ASCENDER Business Release Notes



	ASCENDER Business Release Notes
	ASCENDER Release 6
	ASCENDER 6.0700
	CareerPortal
	EmployeePortal
	ASCENDER 6.0600
	ASCENDER 6.0425
	ASCENDER 6.0405
	ASCENDER 6.0400
	EmployeePortal
	MemberPortal
	ASCENDER 6.0350
	ASCENDER 6.0200
	EmployeePortal
	EmployeePortal
	ASCENDER
	EmployeePortal
	WorkJournal
	MemberPortal


